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HOUSEKEEPING

e [ntroductions

e Pen/pencil & paper

e Cell phones

e Side conversations

e (Questions

e Corrected Handouts

e Breaks

e Restrooms (code: 9033)
e |n case of emergency

e No wandering or exploring
other areas of the building.

o 2019

EDITION

FOLLOWING
INSTRUCT/ ONS

FOR

DUMMIES

WHAT WAS

LEARN HOW g7 P
TO READ AND i
FOLLOW

INSTRUCT / ONS
OF ALL KINDS!
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Overview: Packet Classes

Packet Type lll, Part A ﬂacket Type lll, Part B \
e Role of the Packet Operator e Packet Operations
e Packet Network Overview e Diagnosing Setup Problems

Selecting a BBS
Creating Messages
Event Documentation
Productivity Hints
Exercises

Packet Type lll, Part A+ \ /
e Packet Operations Self-Paced

Exercise workbook

Packet Network Components
Packet Station HW & SW
Accessing the Network
Standard Workflow

Packet Type ll: Advanced Techniques, such as County EOC Packet
Station Setup & Operations, Operating without Outpost.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 3
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Learning Objectives

At the end of this class, you should know how to:
e Verify the setup of an existing packet station
e Select a BBS and connect to it

e Create a message with Outpost and PackltForms
— Properly format the subject line
— Send a proper check-in message

e Retrieve SCCo notices and send local notices
e Produce event documentation for archiving
e Conduct packet messaging field operations

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Fictitious Examples

e We use fictitious call signs in this presentation to avoid SPAM

e \WG6XRL4: Herman Munster

Herman Munster
1313 Mackingbird Lane
Camelot, New Jersey USA

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 5
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I couldn't do my packet homework because
my packet station has a virus.

PACKET IIA HOMEWORK AFTER-ACTION

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 6
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Type Il Part A Homework observations

e For the most part, everyone did quite well.

e Held 2 office hours, about 6 folks showed up with various
guestions from on the homework and BBS access.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 7
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e Messages from the internet ...

e These look like manual messages
created on home email accounts.

e  What happened to the Message ID?!

e Ifyou intend to originate a message
from the Internet into the Packet-world,

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Type Il Part A Homework observations

B R Exercise 45.7a, (PM:868)

File Edit View Actions Windows Help

Archive | Delet

Print | Reply Forward

Private Message
Bbs: W1XSC-1

From: I@yahoo.com
To: lostst@w1xsc.ampr.org

Subjectt _R_Exercise 4.5.7a, "Il

Exercise 4.5.7a,

then as a best practice, create and used your own Message ID sequence.

10/2/2023
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Type Il Part A Homework observations

= )

e The cost of HTML Text email.

File Message

oberma
html vs.

Cc ) Oberhofer

e Several class members saw

first hand turning a 40
character message...

Jim
KN6PE

g™ SN g T ey

e ...into a 2085 character message

More than a 50X size increase in the
text to be transmitted!

Both plain text and HTML text are sent
in the same message.

Bottom Line:
Be careful sending messages into the
packet system from email accts!

And, don’t forget that Subject Line rules
apply here as well.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

v o=

Help

|@att.net

text

Sending message in html.

s

htmi

@ Tell me what you want to do

@w1ixsc.ampr.org’; J Oberhofel}

File Edit View Actions Windows Help

Print = Reply = ReplytoAll anardl Archive | Delete Closel

|8 ~|A

Private Message
Bbs: WIXSC-1
From  obermail@attnet
To: knBpe@wixscamprorg; kn6pe@arrl.net

Rec'd: 8/10/2023 14:13

Subject:  html vs. text

This is a multipart message in MIME format.

Content-Type: text/plain;
charset="us-ascii"
Content-Transfer-Encoding: 7bit

Sending message in hcml.

Content-Type: text/html;
charset="us-ascii"
Content-Transfer-Encoding: quoted-princable

<html xmlns:v=3D"urn:schemas-microsoft-com:vml"™ =
xmlns:o=3D"urn:schemas-microsoft-com:office:office™ =
xmlns:w=3D"urn:schemas-microscft-com:cffice:word" =

xmlns=3D"http://wwWw.w3.0rg/TR/REC-html40"><head><META =
HTTP-EQUIV=3D"Content-Type" CONTENT=3D"text/html; =
charset=3Dus-ascii”"><meta name=3DGenerator content=
3D"Microsoft Word 15 =
(filtered medium)"><style><!--
/* Font Definitions */
@font-face

{font-family:"Cambria Math";

panose-1:2 4 53 546 3 2 4;})
@font-face

{font-family:Calibri;

panose-1:2 15 52 2 2 4 3 2 4;}

Sent 8/10/2023 14:13
Local Msg ID: 6PE-2341P

xmlns :m=3D"http://schemas.microsoft.com/office/2004/12/omml"™ =

| 2,085

9
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/
PACKET FIELD DEPLOYMENT

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 10
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Packet 3A recap

e Packet Network Overview and Components
e Packet Station HW & SW
e Accessing the network

*
- ~———

A
K

e Standard workflow -
e Customizing message handling

e Miscellaneous Outpost settings

e Localizing packet

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

- "":Pé. 1
‘3’

Ve v'-
e Working with messages - Sl 3%
e -

How does this all fit together during a field deployment?

11
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Thinking in terms of a Packet Field Deployment

1. First Shift... when assigned to start up a station

2. |Initial station setup... equipment check-out

3. Packet Operations... managing the message flow

4. Incoming Shift Change... if you are relieving someone else
5. Outgoing Shift Change... if you are being relieved

6. Securing Operations... when directed to shut down

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Packet Field Deployment Process

1. First Shift: Establishing a packet station

Inform Resource Net Control that you have arrived. Check out of
the Resource Net before you leave your car.

Check into the assigned voice net before you leave your car.
Start an ICS 309 Comm Log for the voice net.

Make an ICS 214 Unit log entry.
Sign in on the site’s ICS 211 Check-in sheet.
Find the supervisor and inform them of your arrival.

Request a safety and assignment briefing; get details on any site-
or event-specific conditions that exist. You need to know:

Band and frequency
Primary and secondary packet addresses for any
preferred destinations

Find and establish the workspace to set up packet operations.

1. First Shift
1.
2
3.
4
5.
v/ s
a. Supervisor's Name
b. Activation Number
c. Operational Period
d. ICS Location
e. Your Tactical Call and Message |ID Prefix
f. BBStouse
g.
h.
T.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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v

v

8.

9.

10.

11;

2. Initial setup
Packet Field Deployment Process

2. Initial setup: Equipment check-out

Find, assess, and setup the packet radio equipment
(see Section 3, Packet Startup Procedure)

Confirm or set your User Identification (FCC Call Sign) and
Tactical Call for the assigned agency.

Check settings before transmitting:
Correct BBS in Outpost
Correct Interface in Outpost
Correct radio frequency

Begin packet operations. Make ICS 214 Unit log entry.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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‘\ ‘\ |\ ‘\ ‘\ H\

14.

15.

16.

Ly,

18.

3. Packet Operations
Packet Field Deployment Process
3. Packet Operations: Managing the message flow

12.
13.

Download all notices to ensure you have the latest; read them.

Set up a folder named “SCC Notices” (Tools > General Settings,
Startup tab) and move all notices to this folder.

Send a test message to yourself to confirm you can create, send
to, and receive from the assigned BBS.

Create a Check-In message to your assigned agency using your
Tactical call sign (see Section 5 Check-in, Check-out Message).

Send, receive, log and process packet messages. To only send a
message as soon as it is created, use Actions > Send Only

Manually initiate an Outpost Send/Receive at least every 10
minutes.

If a message was not acknowledged:

a. Check the message address and BBS
b. Resend the message if needed
c. Let your supervisor know

more

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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3. Packet Operations (continued)
Packet Field Deployment Process

3. Packet Operations: Managing the message flow

19. If new notices are retrieved, follow any new instructions.
20. Maintain voice radio contact on the designated voice net.
21. Make ICS 214 Unit log entries as appropriate.

22. Report any issues or problems to your supervisor in person or
over the voice net (if remote).

Tk

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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v

24.
25.
26.

27.

28.
29.

4. Incoming Shift Change

Packet Field Deployment Process

4. Incoming Shift Change: If you are relieving someone else, do the following:
23.

Inform Resource Net Control that you have arrived. Check out of
the Resource Net before you leave your car.

Sign in on the local ICS 211 Check-in sheet.
Find the supervisor and inform them of your arrival.

Request a safety and assignment briefing; get details on any site-
or event-specific conditions that exist.

Find the person you are relieving and receive a shift change
briefing (see Shift Change Information below).

Make packet system updates — Station ID, Tactical Call, etc.
Make all relevant shift change entries in your ICS 214 Unit log.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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v
v

31.
32.

33.
34.

35.

36.
37.
38.

5. Outgoing Shift Change

Packet Field Deployment Process

5. Outgoing Shift Change: If you are being relieved, do the following:
30.

When contacted by your replacement, provide a shift change
briefing (see Shift Change Information below).

Generate and sign a packet ICS 309 Comm Log for your shift.

Generate all event packet documentation for your shift and deliver
as instructed (see Section 10 Archiving Event Documentation).

Turn over all assigned equipment to your replacement.

Find your supervisor and inform them of the shift change and your
departure.

Make the appropriate shift change entries in your ICS 214 Unit
log. Complete and sign the form.

Turn in all paperwork to your supervisor.
Sign out on the site’s ICS 211 Check-in sheet.

Check into the Resource Net. Inform Net Control what you plan to
do (go home, return to EOC, etc.).

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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39.
40.

41.
42.

43.

45.
46.

47.

T RS N

6. Securing Operations
Packet Field Deployment Process

6. Securing Operations: when directed to shut down, do the following:

Get permission from your supervisor to shut down.

Create a text Check-Out message to your assigned agency using
your Tactical Call sign (see Section 6 Check-in, Check-out
Message).

Generate and sign a packet ICS 309 Comm Log for your shift.

Generate all event packet documentation for your shift and deliver
as instructed (see Section 8 Archiving Event Documentation).

Complete and sign your ICS 214 Unit log.

. Shut down and pack up all assigned equipment.

Turn in all paperwork to your supervisor.
Sign out on the site’'s ICS 211 Check-in sheet.
Check out of the assigned voice Net and check in with the

Resource Net. Inform Net Control what you plan to do or where
you will go.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Amateur Packet Radio
Field Reference, Type lli

What is it

Provides a reminder (job aid) for
how to perform tasks that need
to occur during a packet field
deployment.

Helps ensure task consistency,
completeness, and operational
alignment with SCCo RACES
policies and procedures.

What it is not

the only source of information on
which you should rely.

an official SCCo RACES
deliverable.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Amateur Packet Radio
Field Reference, Type Il

For SCCo RACES Responders

September 2023

)

b

20

10/2/2023
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10/2/2023

Initial Setup — Scenario

e Upon arrival at your assignment, your supervisor explains that
someone from the local ham club tried to get the packet
station working. They were unsuccessful and had to leave.

e He takes you over to the hardware:

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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No Problem! ... Right?

e Assembling and configuring a packet station is simple
e And problems are rare, especially for regular users

e But at some point ...
... especially when using someone else’s gear,
... you may face at least one of these problems

e Use alogical process to find and resolve problems

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 22
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Verifying Packet Station Readiness

1. Connections

2. Initial power-up

3. Equipment settings

4. Application settings

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 23
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1. Connections

— Fusel = 1A (typical)

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Fuse1 Fuse2
Power Supply
PC/Laptop TNC Radio
e Comm Port, or e Serial (or USB) cable e Antenna coax connected
e USB port and a e Custom TNC/radio cable e Power cable, fused, to
USB-to-Serial adaptor e Power cable, fused, to power supply or battery
e Windows USB Driver power supply or battery — Fuse2 = 15-20A (typical)

24

24
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1. Connections — What You May See

Here is what you see when you find the hardware...

Goﬂneo\O‘ V5 ) . " - Do you
& ' have an

adapter?
-

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 25
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1. Connections — After Correct Assembly

You’ve straightened out the hardware and cabling

E -

To prevent problems, especially on shared stations,
Consider labeling the TNC and radio interfaces

3 : ::'r:' =

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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2. Initial Power-up

power adaptor is
plugged in

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

$ Fuse1 Fuse2
Power Supply
PC/Laptop TNC Radio
e Laptop boots up e Apply power e Apply power
e Battery charged, or e Power LED lights up e Radio turns on correctly

27
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2. Initial Power-up - TNC

e |F: TNC power cable is plugged directly into a RigRunner

RIGrunner 4005

e AND: TNC’s power light is on

— You may or may not notice that it appears a little dimmer than usual.

e BUT: No response from the TNC via a serial connection;
it behaves like it’s turned off.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 28
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2. Initial Power-up - TNC

e THEN: It probably IS off!
e Check the RigRunner. Is there a red light on behind the fuse?

— Replace the fuse
— RigRunner lights an LED behind the fuse when the fuse is burned out

— But the current needed to power the fuse LED is just barely enough to
light the power light on the TNC (dimly)!

e Or, try another port on the RigRunner.

— Your model may not have an LED light or it may not be working
e Or, try another power cord

e Avoid blowing a fuse:

— ALWAYS plug the power cord into the TNC first, then into the power
source.

— This avoids the chance of the TNC power connector plug tip touching the
TNC chassis, thereby shorting positive to ground, and blowing the fuse

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 29

29

A CAarvvrinht ONOA CQAanta Clara Cnrilinthy AREQCSY/PPACEC All rinhte racarm/ad 20



Packet Operator Type Ill Part B

PC/Laptop Settings

e Terminal Program:

Comm Port Setting
— Com Port #
— 9600 baud
— 8 data bits
— No parity
— 1 stop bit
— RTS/CTS flow control

3. Equipment settings

e i
—— I
?Fuse1 Fuse2
Power Supply
TNC Settings Radio Settings
e Comm Port Settings e Correct frequency
— 9600 baud e No Tone

e Other KPC-3s default e No offset

to 8-N-1 e Squelch open
e Carrier Detect settings e High power

— INTFACE TERMINAL
— CD SOFTWARE

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

e Correct side is selected
for packet

30

30
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3. Equipment settings — TNC

What could go wrong?

Meaning, what are the symptoms?

Can’t find the Com Port for my USB-Serial adaptor
TNC is stuck in Autobaud routine

When | type something, | see garbled text

Can’t communicate with the TNC

A A

Wrong audio output level

If you are stuck here and cannot ‘talk’ to the TNC, do not even
try to proceed to the next step!

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 31
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3. Equipment settings — TNC
USB-Serial adaptor problems/missing PC Com Port

Most TNCs use: 9600 baud, 8-N-1, RTS/CTS

Outpost:
_ _ Setup > Interfaces ... > [Choose TNC] > Comm Port
Windows: ffy Device setup for XSC_Kantronics_KPC3-Plus X
& Device Manager — O

Type | Prompts | TNC Cmds | InitCmds  Comm Port ] AGWPE | Telnet |

File Action View Help P PG Ipserial:

e = H= comm Pt [0 ~ CEsho Setup > Comm Port Settings
> & Display adapters e O {* [On L5 Comm Port Setup X
> i Firmware QEUDEI ;
> F#l Human Interface Devices I —:J Flows Contral .

L oit;

> IDE ATA/ATAPI troll -
R A SARHERee Connection Preferences " Maone

. ; : M ax Speed
._|.. Imaging devices Data Bits: m _ —
> = Keyboards o+ RTS/CTS ﬂ i (] (=
> @ Mice and other pointing devices Parity: [Mone = .
> [ Monitors Connection Preferences Flaws Cortral

% Network adapt Stop Bits: |1 - Data Bits: |3 -

I? etwork adapters . " Mone

ﬁ Ports (COM & LPT) L P arity: Mane - f« RTS/CTS
- ﬁ. USB Serial Port (COM3) Stop Btz [1 =
> = Print queues

> n Processors
» W7 Security devices

B Software devices

OK
Ij Sound, video and game controllery
> ‘E}n Storage controllers
> E3 System devices v
118 Cancel
Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 32
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KPC-3’s Autobaud Routine

Ipserial with Outpost

Eile Edit Setup Tools Help
Disccnnedl Start Logaing |

3. Equipment settings — TNC

e With everything properly connected and powered on, you might see this...

PRESS (*) TO SET BAUD RATEDbL
PRESS (*) TO SET BAUD RATEb
PRESS (*) TO SET BAUD RATEb
PRESS (*) TO SET BAUD RATEb
PRESS (*) TO SET BAUD RATEb

[P TIEY]

L0 I o I I T N O A L I
200
BBt BB B BB

tRE] €ceExii<BEx<] €oEx<] =E "€~ £

€] EceceExuEx<yjEx<€€] x<=€~€3£0 3 3] 3"

tRe] ecceceeeecexiiEx<8xaxAeeex<] $x<] =€~00 3~ ~~£10 30 Acf
tRe ecccceceEExii€otx<] pxE"EA" £

tRe]| sessext<BEx<]| E€x=="€3Ff0 3 3a"F

PRESS (*) TC SET BAUD RATEDb ibell ececcecsecexue] x<e€ex< =€7€0] 37"

PRESS (*) TO SET BAUD RATEb CE thell ssesessssexu<dex<] €pex<] $x<€€<] x<=€"€3£f0 3 2

PRESS (*) TO SET BAUD RATEb P CE }Be] scscceeseeeeeeeseexi<] €x<]| o=l 3] Acf

PRESS (*) TO SET BAUD RATEb P CE }A€] cessesexucx<yex<eAex<OxaxAeeex<]=e €] 3~~] ~~£][ 30 Ae£
PRESS (*) TO SET BAUD RATEb P CE }B€l €esceeexuex<yex<eel x<eeex<l

w

Connected to the TNC Settings: 9600,N.8,1 on Comm Port 10, STD TNC

00:10:32

baud after another.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

e This is the KPC-3 Autobaud routine that assures that the KPC-3 Plus baud is the same
as that for whatever communication software you are using.

e AUTOBAUD sends and resends the message “PRESS (*) TO SET BAUD” at one

e  When the KPC-3 baud matches that of your terminal program, you can read the text.
e When the two bauds do not match, the message appears garbled, if it appears at all.

33
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KPC-3’s Autobaud Routine

e WHEN does this occur:

— Dead TNC memory battery

e HOW to fix:

usgn

text, immediately press the key.

— Then, enter the following commands:
ENTER YOUR CALLSIGN=> W6XRL4
cmd: INTFACE TERMINAL
cmd: CD SOFTWARE

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

3. Equipment settings — TNC

— The first time your KPC-3 Plus is ever used (from the factory)

— User performs a hard reset with the RESTORE DEFAULT command

— Get ready... when you clearly see the PRESS (*) TO SET BAUD RATE

(your call sign or tactical call)
(enables the full TNC command set)

(TNC Carrier Detect is performed in
software; lets you keep the radio
squelch open)
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3. Equipment settings — TNC

More on the TNC Carrier Detect command

e We recommend operating the packet station with the squelch
on the radio fully open (static/hiss all the time)
— Allows the TNC to receive the weakest of signals
— Unaffected by poorly chosen squelch level on the radio

e |f squelch is open and the TNC’s “Receive” light is on all the
time, then the TNC’s carrier detect mode is incorrectly set

e After setting cD SOFTWARE, the TNC’s “Receive” light is only on
when packets are heard

e To do that for a Kantronics TNC, at the TNC Prompt, enter:
— cmd: CD SOFTWARE
— Carrier Detect performed by the TNC software, not squelch-dependent

— Other TNCs default to this option (Timewave) or have a different
command for this option; check your TNC manual

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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3. Equipment settings — TNC
Some more on the Intface Terminal command
Full Command Set

e After a hard reset, the Kantronics TNC puts you in NEWUSER mode.

e NEWUSER mode allows only the most basic commands. As a result,
you might see this:

Ipserial with Outpost
File Edit Tools Help

[Czconnect Start Logoing 2 A

8

HAWTRONICS PACKET COMMUNICATOR III WVERSION 8.2
(C)y COBPYRIGHT 1988-1997 BY HANTRONICS INC. A4ALL
RESERVED.

DUPLICATION PROHIBITED WITHOUT PERMISSION COF KAb
cmd:cd software

Command not available in NEWUSER mode
cmd :

Oops, Wrong mode

Connected to the THEC Sethngz 9600 M 8.1 on Comm Port 2 | 000017

To fix, at the cmd: prompt, you type:
cmd: INTFACE TERMINAL (allows all commands)
cmd: CD SOFTWARE

e Now, the RCV light only lights when the TNC hears packets

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Garbled text

e What you see:
— Press a key, see garbled text.

e WHEN does this occur:

— TNC previously worked great!
— But someone changed the
program’s baud rate

e HOW to fix:

1. TNC baud is likely 9600

2. Change the program baud
Setup > Com Port Settings,
change baud to 9600...

3. Disconnect, Reconnect, press
any key.

4. Try other baud rates if this
does not fix it.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

3. Equipment settings —

TNC

E Ipserial with Outpost

File Edit Setup Tools Help

Disconnect |

HB@*R*IBg; [O¢m&_PI000 yyyyyyyyyUsyyrey

Connected to the TNC

gettings: 2400,N,8,1 on Jomm Port 10, STD TNC
el

Ipserial with Outpost

File Edit Setup Tools Help

Disconnect | { l

HB@*R*IBg; [O¢ma PI000 ¢y¥9y¥yy¥UsyyrryYyMONITOR ON
-~
»

EH?

cmd

cmd

Connected to the TNC eftings: 9600,N,8,1 onpomm Port 10, STD TNC

37
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e What you see:
— TNC previously worked great!

e WHEN might this occur:
— Someone or some program
put the TNC in KISS mode

e HOW to fix:
1. Start Ipserial

5. TNCis restored to TERMINAL
mode

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

3. Equipment settings — TNC
Can’t communicate at all with the TNC (#1)

Ipserial with Outpost

Disconnect

|<enter> <

— The cable, USB drivers, and power are good, and no blown fuse
— But Press any key and | get no reply

File Edit Setup Tools Help

Get Com Port Settings from Outpost
Create Message in Outpost

Kantronics Kiss Off
Kantronics Host Off
AEA Kiss Off

AEA Host Off
PacComm Kiss Off

View Outpost Data Directory

Font
Reset Font

INC. ALL R
;ION OF KANT

KANTRONICS
2. Verify the TNC Com Port (C) COPYR:
DUPLICATIC(
and baud rate cmd:
3. Verify Com Port Connect, then ||/
4. Tools > Kantronics Kiss Off

‘ Connected to the TNC Seftings: 9600,N,8,1 on Comm Port 10, STD TNC

38
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3. Equipment settings — TNC
Can’t communicate with the TNC (#2)

If you have a USB-Serial Adaptor, it is likely
to be a problem with the USB-Serial Adaptor Driver.

Windows Device Manager is next.
e Device Manager is a Microsoft Windows O/S tool.

e |t allows users to view and control the hardware attached to the
computer.

e When a piece of hardware is not working, the offending hardware is
highlighted for the user to deal with.

e Torun Device Manager...
1. Press Windows key + R key together to open a Run box.
2. Type devmgmt.msc, press OK. Device Manager opens.

3. Or, enter device manager in the Windows Search field on the task
bar... Device Manager opens.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Can’t communicate with the T

e Find and expand the
Ports (COM & LPT) dialog.

e Don’tseeit? Then check:

USB-Serial connector is
attached to the PC

— For KPC3+ USB, make sure
KPC3 is powered on

e Also, try
— View > Show hidden devices

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Windows Device Manager

g_; Device Manager

;i Device Manager File. Action [SHTeW Help
File Action View Help @ = | 0| 81 Devicesby type L
. = v f Devices by connection
Y i ETI-‘ [;j «w Den2 . .
i i Aud Devices by container

v Den201_B _ 0 Blue Resources by type

i} Audio inputs and outpui B con
—_ Resources by connection
9 Bluetooth s Disk
B computer [# Disg| 4 Show hidden devices
== Disk drives o8 DVL
Bl Display adapters i Eitre Customize..
= DVD/CD-ROM drives il Human Interface Devices
i Firmware <i2 Imaging devices
¥y Human Interface Devices E2 Keyboards
"\\‘ % 4
={s Imaging devices  Mice and other pointing devices
=2 Keyboards Il Monitors
@ Mice and other pointing I Network adapters
£ Monitors v E? Other devices
I Network adapters E' USB-SER!
B Portable Devices B portable Devices
= Print queues ~ @@ Ports (COM & LPT)
=l Printers W Arduine Uno (COM4)
O Processors W ELTIMA Virtual Serial Port (COM10)
B security devices ! Keyspan USB Serial Port (COM?7)
I software components ' Prolific USB-to-Serial Comm Port (COMS5)
B Software devices Wl Prolific USB-to-Serial Comm Port (COM3)
i Sound, video and game ) USB Serial Port (COM3)
S Storage controllers i USB Serial Port (COMS)
E® System devices ) USB Serial Port (COMB8)
§ Universal Serial Bus cont 7 Print queues
¥ Universal Serial Bus devi = Drintare
= WSD Print Provider D]splays |egacy devices a
40
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Windows Device Manager
Can’t communicate with the TNC

1. Find and expand Ports (COM & LPT) dialog.
2. You should see something like this...

E_ Portable Devices or Portable Devices
~ W Ports (COM & LPT) " v i Ports (COM & LPT)
W Keyspan USB Serial Port (COM?7) ' USB Serial Port (COM3)

= Print queues .
= q = Print queues

3. You do not want to see anything like this...

v RY Other devices Portable Devices
B4 USB-SER! Ol L & Ports (COM & LPT)
B Portable Devices ' PL2303HXA PHASED OUT SINCE 2012
= Print queues = Print queues

Il These are not all the problems you might see.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 41
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Yes, you have a problem... now what?
Can’t communicate with the TNC

e Troubleshooting USB-Serial driver problems is a
class by itself... we do not have time to cover it here.

e However, here are 5 (not all) things you can do:

1. Review the SCCo RACES USB-to-Serial Adapter page... Data Networking
> AX.25 over VHF > Equipment and Software > USB-to-Serial Adapter

2. Post your problem or questions to the packet email list. It is likely
there are SCC RACES packet ops who have encountered and solved
this problem before.

3. Ifyou know the USB-Serial adaptor chipset, try searching,
downloading, and installing its Windows driver.

4. Buy yourself a new USB-Serial Adaptor, then label it, practice with it,
build confidence with it, put it in your packet kit, and deploy with it.

5. Lastly, if you have a bunch of old, unknown, or confirmed non-
working USB-Serial Adaptors in your junk box, then throw them out
NOW and save yourself from future headaches.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 42
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3. Equipment settings — TNC

Wrong audio output level

e The TNC sets the audio output level (transmit drive audio) to your radio.

e The transmit drive level can be set from the command line, but it implies
you know to what value it should be set.

e While calibrating the drive level is beyond the scope of this course, being
able to view and set a previously determined value is in scope.

e Toview the currently set transmit drive level:
cmd : XMITLVL (xM for short command)
XMITLVL 100 (displays the value. Default=100, range is 0 to 255)
e To set the transmit drive level:
cmd : XMITLVL 180 (example)
XMITLVL was 100

Ipserial with Outpost

File Edit Setup Tools Help

Disconnect | ‘

XMITLVL

e Most packet station owners will have the | jxurrive 100
cmd : XM
XMITLVL written down. If you cannot find | [xurrzve 100

. . . cmd: XMITLVL 180
it, see your Shift Supervisor. KMITLVL was 100
cmd : XMITLVL
XMITLVL 180
cmd:

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 43
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3. Equipment settings — Radio Frequency

e Use the correct frequency for your primary or secondary BBS

Call Sign | AX.25 User Access BBS-BBS | Location

WIXSC | WIXSC-1 || 145750, 223 620, 433 570 Santa Clara Co Office Bldg (San Jose)
W2XSC | W2XSC-1 || 145.730, 223.560, 433.590 Crystal Peak (South County)

W3XSC | W3XSC-1 || 144 310, 223 540, 433 450 Palo Alto

WAXSC | WAXSC-1 || 145.690, 223 .600%, 433.550 | 223.600 | Frazier Peak (above Milpitas)

http://www.scc-ares-races.org/freqs/packet-fregs.htmi

e The same information is available as a packet notice

Frequencies are in MHz.

Call Sign AX.25 Connect User Access BBS-BBS Forwarding
W1XSsC W1XSC-1 145.750, 223.620, 433.570

W2XsC W2X5C-1 145.730, 223.560, 433.590

W3XSC W3X5C-1 144.310, 223.540, 433.450

W4XSC W4XSC-1 145.690, 223.600*, 433.550 223.600

4223.600 is primarily for BBS forwarding; user access should be limited to
emergency/backup situations. Interference to/from other BBSs will be significant.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 44
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3. Equipment settings — Radio Settings

e Everything is now on. You are supposed to use the W2XSC
BBS. But no packets are heard.

Voice side is set for
transmit

t

Varies with radio
settings

Of,%e

Frequency is
incorrect

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 45
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3. Equipment settings — Radio Settings

e You change the radio settings
— High Power

— Correct Frequency
— Squelch is open (BUSY)
— Correct side is set for packet (dual rcv/xmt radios, only)

e Some radios “force” packet to a particular side

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 46
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4. Application settings

S
?Fuse1

—_—);

Fuse2

Power Supply

Application Settings
e Station ID

e Tactical Call

e PCTime

e BBS

e TNC

e Other Outpost configurations

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Starting Outpost > Station ID

* You get to the Outpost Station ID screen....

(3 Station ID is W6XRL4 as XNDEOC

Identification ] BBS Logins | Signatures

Current Profile: |Dutpnst
Legal

Lzer Call Sign: | WEXRLA

B

User Name: [Herman Munster
Meszage 1D Prefis: |y [3 Characters max)

Is this your call sign,

name, initials?

Tactical
Have you been [w Usze Tactical Call for all BES interaction
q . Tactical Call Sign: =
assigned a tactical | XNDEOC =] New
. Additional 1D Text: |yvanadu EOC
call S|gn? _ | Delete
Meszage ID Prefis: [yyp (3 Characters ma)
¥ Show ths o on st o ol

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Outpost PC Time Check

PC Time Check v3.5.0

Your PC's current time
Is the date and
‘ 11:37:38

Monday, 19-Sep-2022 .
\/lme correct?
Ifthe Date or Time is incorrect, then press Update and

setthe correct date and time for your PC.

{ Update | Close |

Correct date and time is important!
It will be used in a variety of places.
Verify each time you start up.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 49
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Checking the BBS and TNC settings

', 1% Outpost Packet Message Manager — a X
File Edit 5Setup Tools Forms  Actions Help
Mew ‘ Cpen | Archive ‘ Delete | Print | Send.n’Receive-l F'mﬁle:l COutpost j
Folder List In Tray
U | Type | From | To | BBS | LocallD | Subject | DateTime |  Size |
Qut Tray
Iternz: 0 Unread: O ‘WBXFEL-Q az #MDEOC - KSI:_WEXSE-‘I - #5C Fenwood _TH-D7104 [Com3) ‘DD:DEI:EID ‘15:08:41 y

/

... but you were assigned to W2XSC

... and you have a KPC-3+ TNC

e After setting the BBS and TNC, we are ready to go.

;_(E Outpost Packet Message Manager — O X
File Edit 5Setup Tools Forms  Actions Help
Mew ‘ Cpen | Archive ‘ Delete | Print | Send.n’Receive-l F'mﬁle:l COutpost j
Folder List In Tray
U|Twpe | From | To | BBS | LocallD | Subject | DateTime |  Size |
Qut Tray
Iternz: 0 Unread: O ‘WBXFEL-Q a3z AMDEDC - ®SC_WEZHSC-1 - %5C_Kantronics KPC3-Pluz (Com3) ‘DD:DEI:EID ‘15:09:42 y

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Best Test? — Press Send/Receive

File Edit Setup Tools Forms  Actions Help o
New | Open | Archive | Delete | Pn'ritQ Send/Receive

In Tray [ulTwelFrom 7o | BBS I

Ahort S eszion |

CPACTIME was OFF
cmd: STREAMEV OFF
STREAMEV was OFF

You are talking to the TNC! —  [cmd:sTReAmsw $00

- . STREAMSW was $7C (|)
TNC prompt = cmd: omd:
_ Icmd:connect w2Xxsc-1
cmd: *¥** CONNECTED to W2XSC-1
[INOS-2.0k.1.xsc.1-IHMS$]
You have 0 messages.

You are talking to the BBS! —  [¢® >

XM 0

JNOS BBS prompt = >’ #0) >

A XSCPERM

Retrieving Message List...

00:00:04

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Where should | connect?

SELECTING A BBS TO USE

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 52
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Selecting a BBS

e Santa Clara County ARES/RACES operates six BBSs
— FCC Call Signs: W1XSC, W2XSC, W3XSC, W4XSC, W5XSC, W6XSC

e All six are identical in function but operate independently to
maximize survivability during disasters

e All six have appropriate addresses for AX.25 packet radio, the
Internet, AMPRnet, BBS Network and NetROM

Call Sign | AX.25 Internet/AMPRnet BBS Network NET/ROM Alias

W1XSC | W1XSC-1|| wixsc.ampr.org || wixsc.#nca.ca.usa.noam XSCBB1

This information
is also available
as a packet
notice in the
Xscperm area

W2XSC | W2XSC-1 || w2xsc.ampr.org || w2xsc.#nca.ca.usa.noam XSCBB2

W3XSC | W3XSC-1 || w3xsc.ampr.org || w3xsc.#nca.ca.usa.noam XSCBB3

W4XSC | WAXSC-1 || wdxsc.ampr.org || wAxsc.#nca.ca.usa.noam XSCBB4

W5XSC || WoXSC-1 || wbdxsc.ampr.org || woxsc.#nca.ca.usa.noam XSCBB5

W6EXSC | WEXSC-1 || wbxsc.ampr.org || wGxsc.#nca.ca.usa.noam XSCBB6

https://www.scc-ares-races.org/freqs/packet-freqs.html

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 53
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Selecting a BBS

e Each city/agency has a “primary” and “secondary” BBS
— Minimizes hidden nodes
— Distributes load on our radio channels
— Eliminates BBS-to-BBS forwarding for messages within a single agency
— Makes it easy to know where to send messages

# |Agency Prefix Primary BBS Secondary BBS
Santa Clara County Cities and Agencies
1 | American Red Cross ARC W1XSC W4XSC
2 | CAL FIRE VIPs - Santa Clara Unit SCU W2XSC W1XSC . . .
This information
3 | Campbell, City of CBL W1XSC W4XSC . .
is also available
4 || Cupertino, City of CUP W1XSC W4XSC
as a packet
5 | Gilroy, City of GIL W2XSC W1XSC . .
notice in the
6 | Hospitals (all SCCo) & MHJOC HOS W2XSC W1XSC
Xscperm area
7 || Loma Prieta Region LMP W2XSC W1XSC
8 || Los Altos, City of LOS W3XSC W1XSC

https://www.scc-ares-races.org/freqs/packet-freqs.html
Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Selecting a BBS

e Connect to the primary BBS whenever possible
e Otherwise, connect to your secondary BBS
e QOtherwise, connect to whatever BBS you can reach

e Access frequencies
— EOCs should use 1.25m (220) whenever possible, because ...
— Most individual users will be on 2m or 440

e Action Items

— Print out and keep a copy of the Packet Frequencies and BBS Listing
page in your go kit (maps cities to Tactical Calls to BBSs)

— Keep a copy of the equivalent packet notices in an Outpost folder
— Know your own primary and secondary BBS call signs!

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 55
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BBS Connect Names for AX.25 Packet Radio

Call Sign| AX.25 |User Access BBS-BBS | Location

WIXSC | W1XSC-1 |]145.750, 223.620, 433.570 Santa Clara Co Office Bldg (San Jose)
W2XSC | W2XSC-1 |]145.730, 223.560, 433.590 Crystal Peak (South County)

W3XSC | W3XSC-1 |]144.310, 223.540, 433.450 Palo Alto

WAXSC | W4XSC-1 145690, 2236007, 433.550 | 223.600 || Frazier Peak (above Milpitas)

WHX5C | WHXSC-1 Jvaries varies Training, events, backup

WBEXS5C LWEXSCJ varies varies Testing, backup

https://www.scc-ares-races.org/freqs/packet-freqs.html

« The AX.25 protocol uses an SSID (Secondary Station |Dentifier):
« The “-1” following the call sign... W1XSC-1

* Allows more than one device, or more than one service on a device, to
use the same FCC call sign on the same frequency

e The BBS mailbox function on all SCCo BBSs uses an SSID of 1

» To connect to your mailbox on an SCCo BBS using AX.25 packet radio, you
connect to:
W1XSC-1, W2XSC-1, W3XSC-1, W4XSC-1, W5XSC-1 or W6XSC-1

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Selecting a BBS in Outpost

1w BBS setup for X5C WI1LKEC-1

e Setup > BBS ...

e The SCCo Installer includes
setups for all SCCo BBSs

e All SCCo-supplied setup _—

M arne l F'n:umpts] Cormrmands | Init Enmmandsi F'ath]

BES Hame

wﬂ XSC_WIXSC-1 |

Connect Marmes ]wmgc,»]
. «“ ”
names Start Wlth XSC_ WSEM& Clara County ARES/RACES Packet
. System. Located in San Jose. JNOS.
e For the W1XSC BBS, you will _—~— Frog: 145750 :

connect to W1XSC-1 bES Type

(¥ LetOutpost determine the BES and zet up the prompts
(" Uszer defines the BES prompts

e Then tune your radio to

Mon-ldentifving BBS =

" As4RE BBS
proper frequency from your (" AA4RE BES with Tactical Call Customization
BBS frequency list TNC Name

.......................................

Eat/Get TNE || [XSC_Kantronics_KPC3-Plus

.......................................

] Apply

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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CONNECTING TO YOUR MAILBOX

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 58
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e BBS “logins” are based on the call sign
used by the connecting station
— Defined by the TNC’s “mycall” setting

— Qutpost sets this automatically based on
information in Setup > Station ID...

e The call sign can be either an FCC or
tactical call sign
— FCC call sign: W6XRL4 (Herman Munster)
v’ Tactical call sign: XNDEOC (Xanadu EOC)
v Additional ID Text: where you are located
v’ Message ID Prefix: unique identifier

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Call Sign Determines “Login” and Mailbox

Setup > Station ID ...

w Station ID is W6XRL4 as XNDEOC

Identification | BBS Logins | Signatures |

Current Profile: [Outpost
Legal

User Call Sign: | WEXRL4

UserName: |Herman Munster
Message ID Prefix: -y (3 Characters max)
Tactical

[v Use Tactical Call for all BBS interaction

Tactical Call Sign: | XNDEOC

Additional ID Text: IXanadu EOC

Message ID Prefix: (3 Characters max)

[~ Show this form on startup

NOW ALSO REQUIRED!
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Tactical Call Signs

e Tactical call signs must be pre-defined before use

— Your City/Agency EC/AEC can request tactical call signs as needed
https://www.scc-ares-races.org > Packet BBS > How to Request Tactical Calls

e You can connect to any SCCo BBS using any valid tactical call
sign, but:
— You should only do so when assigned by your city/agency
— You should use the primary BBS for your agency
— You should only use another BBS if authorized by your city/agency

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 60
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CHECK IN

CHECK OUT

CHECK-IN/OUT MESSAGES

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 61
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— They inform the EOC or other “net contro

Check-In/Out Messages

e Properly formatted Check-In/Out messages are important

Recipient can easily find them among other messages in the In Tray

II)

which stations are ready

— They are part of DSW supervision
e General rules during field assignments

Check in and out using your assigned Tactical Call, not your FCC call

g
Check-in as soon as the station is ready

Check-out before shutting down the station using your Tactical Call
Always send as plain text messages

”

Always use [HandlingOrder] =“ R_
e Handling Order = R (Routine)
Always follow the standard subject line format
¢ With specific check-in/out details for subject and message body

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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w, Station ID is WEXRL4 as XNDFS1

Identification | BBS Loglns| Signatures |

Current Profile: |Outpost
Legal

User Call Sign: | (3G

User Name: IHerman Munster

Tactical

Message ID Prefic [RL4 (3 Characters max)

v Use Tactical Call for all BBS interaction

Tactical Call Sign: ] XNDFS1

Additional ID Text: [}(anadu Station 1

Message ID Prefix |[Fgq (3 Characters max)

Check-In/Out: PackltForms

e PackltForms includes a Check-In/Out message form
— Option for both check-in and check-out messages
— Handles FCC call signs and Tactical Calls

— Correctly formats the subject line and message body

C @

y

O D 127.00.1:56732/form-2

Submit to Outpost | Submit via Email|  Reset Form |

[~ Show this form on startup

OK

Cancel

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Message number:

Your Call Sign:
Use Tactical Call:

FS1-1772P

(@checkin O Check Out

W6XRL4 Name: Herman Munster
XNDFS1 Name: Xanadu Station 1

PR FS1-1772P_R_Check-In XNDFS1, Xanadu Station 1 (PM:342)

File Edit Actions Window Help

Sendl Print | Save | Delete Close‘ Urgl Pvt | Bul N

BB abemeaet®  Private Message

Bbs: |W1XSC-1

From: [XNDFS1

To... [[XNDEOC@W1XSC

Subject: |FS1-1772P_R_Check-In XNDFS1, Xanadu Station 1

Check-In XNDFS1l, Xanadu Station 1
WEXRL4, Herman Munster|

63
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e What’s new!
— There are no longer scheduled rotating BBS outages
— You do not have to create your own message content.

— You will send a message form that is virtually handed to
you by viewing it on the instructions page.

— Visit scc-ares-races.org/pacpractice to get instructions!

e To participate:

— Check in any time during the week before 19:00 on the
day of the net

— The instructions are different each week
— Software will test your check-in for accuracy

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Practice: Weekly SPECS/SVECS Nets
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CREATING A MESSAGE

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 65
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Creating Messages with Outpost

E Outpost Packet Message Manager 4
Fi

S

it Setup Tools Forms Actions Help

(

e Start a new message:

Press New
— Fill in all remaining fields

e Multiple source options

Free-form plain text

e Supports TAB characters,
reducing the character count

Cut and Paste from other
apps, like Word, Excel

File > Open a File, then
choose a .csv file

Import text files directly into
the message form
Press Send

— Message goes to Out Tray

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

New) Open | Archive = Delete Print | Searchl SendIReceivel Profil

Local ID | Subj:

xsceoc... XSCPERM

xsceoc... XSCPERM W1XS... '
xsceoc... XSCPERM W1XSC-1 6PE-2... SCC,
xsceoc... XSCPERM W1XSC-1 6PE-2... SCC.
xsceoc... XSCPERM W1XSC-1 6PE-2... SCC

MmO m R

- xsceoc... XSCPERM W1XSC-1
i P New Packet Message (PM:1246)

7 File Edit Actions Window Help Popup Menu

Sendl Print | Save  Delete Close| Urgl Pvt | Bul NTS|

Private Message

Bbs:
From:
To...
Subject:

W1XSC-1
XNDEOC

XND-1363P
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Outpost Message Window Details

s 03P _R_JellyDonut Request - Packet Message
Autofilled _
from Tools > Actions Window Help Popup Menu

Report Settings > ; ! ! =
Next Msg Number Print | Save | Delete! Close Llrgl Pt | Bul | NTS ﬁl J A Al

vate Message

— Autofilled from Setup > BBS
bs: |W1IXKSC-1
Frox |wixgpL4 < Autofilled from Setup > Station ID

To.. Nndeoc@w2xsc.ampr.org 4| Filled in by you
subject: |XND-1363P_R_JellyDonut Request <«— Filled in by you or autofilled by PacklItForms

Please pick up 1 dozen jelly donuts.

Thanks.
Herman| Filled in by you or autofilled by PackltForms

67

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

67

AR7

A COAarvrinht ONO2A CQaAanta Clara Cnrnilinhy ARECAY/RDACEC All rinhte raecam/ad



Packet Operator Type Ill Part B

Message Prioritization

e Prioritize according to handling order, then date/time
— Handling order: Immediate, Priority, Routine
— Use Date/Time to prioritize between same handling order
— Ultimately, the served agency decides the order

Message Numbers: Origin: FS1-1779P
Date: ©9/19/2022 Time: 19:44 Handling:
ICS Position: Planning Section

T Location: County EOC

O Name:

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

S0am

Santa Clara County EOC Resource Request Form 213RR Version: 817

BIES213

Destination:

O Immediate (ASAP) O Priority (<1 hr) @ Routine (<2 hrs) 1

ICS Position: | |
Location: | '

Name:

68
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* 3-character message prefix for the .
originator, a hyphen, followed by a
message number.

e OQutpost adds a P suffix if it

generates the message number [Su

NOTE on Immediate mess
Immediate messages are usually are sent
by voice. But, if an Immediate has to

message is coming their way by packet.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Standard Packet Subject Line

[OriginatorMsg#] [HandlingOrder] [Subject]

Example: XND-200P_R_Packet 3B Class Exercise Instructions
[OriginatorMsg#] [HandlingOrder]

1-letter indicator as follows:
* | =Immediate

* P =Priority

* R =Routine

bject]

Short description of the contents
of the message

Autofilled by PackltForms or
entered by you

be sent via packet, send it PLUS send/receive asap, and also contact the TO: party by
a voice net (e.g. command net, message net) to let them know an Immediate

69
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Why The Subject Line Matters

e The receiving station must process messages according to
handling order, then date/time

— Must be able to easily scan the subject lines

e Which is most important? What is handling order?

Subject

PTS-834P Urgent: Need bulldozer
PTS-835P Water distribution
PTS-836P Barricades

e How about now?

Subject Even a large In Tray is easily scanned
PTS-834F rgent: Need bulldozer

PTS-835F ater distribution

PTS-836p | Barricades

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 70

70

A CAarvvrinht ONOA CQAanta Clara Cnrilinthy AREQCSY/PPACEC All rinhte racarm/ad 70N



Packet Operator Type Il Part B

PackltForms

to O I

it via Email

Message number: 6PE-618P

IOy ChackIn - O Chark Ont |

Your Call Sign: 1 to Outp I bmit via Email
] Use Tactica
MESSAGE FORM | Orinin Man #- 2 ‘ Naatinatinn Man - 3
Iszg% IS F submit to Outpost| Submit via Email | Reset Form | Show PDF -
Date ':
& Version: 8/17
Santa Clara County EOC Resource Request Form 213RR S
07/23/2022 — : ==
= Submit to Outpost || Submit via Email I Reset Form |  Show PDF Show Text Message ||~
Date: e6/21/
ICS Posi =
ICS Posit| =
+| Locat Locations | SNta Clara OA Jurisdiction Status HiebECCE201 ey
= :
O Name: 0| Name: Message N . . =
e to Outpost | Submit via Email I Reset Form | Show PDF Show Text Message
Telephot Contact I Date: e6/21/
Subject: 10 7 ICS Posit| -
f-'m“ﬂ —|  Santa Clara OA Shelter Status ¥icbEOC 20190011
T Location; ‘ ‘ s
. 12| | 5.Requested | O Name: | MessageN
Message: Hame to Outpost | Submit via Email I Reset Form || Show PDF Show Text Message |
Contact | | Date: 86/21/
[ty Allied Health Stat R rt Short F Version: February 2018
Report Type: || oo Allied Hea atus Repo ort Form (DEOC-9) Heor
T 1 B T T
5 - ge N
EOC Phone: Contact | Date: e6/21/
Primary EM C{ | Report Type: I6s Posi 2 Version: 20220129
| Santa Clara County RACES -- Mutual Aid Request S
Secondary EM | shelter T | Location: S
Name: © Name: | Message Numbers: | Origin: RL4-2246P ‘ Destination:
. Shelter Type: ;
Government O | status: Contactj Date: @6/21/2e23 ‘ Tsme:“hh:mm I” Handling: O Immediate (ASAP) O Priority (<1 hr) @ Routine (<2 hrs)
Office Status: | | Name: Report 1ype=| ICS Position: RACES chief Radio Officer v . ics Posmon:l
Expected to O| | Address: fmmum ¢ | Location: county Eoc r Location: |
Expected to C| | City: O Name: : Name:
State: Contact Nam Contact Info: Contact Info:
Zip: Other Phone, Agency heme: l
Latitude: Event/ Incident Name: l Number:

Shelter Inforry | Facility Statui | Assignment

Duties, conditions, equipment, shift times

Green - Fully A
Red - Limited
Black - Impaire

Y

Eanities mamed | Amateur Radio Qty Role Position
<

Preferred Type Minimum Type

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

fRstofimes ‘ 'I vl for example, Checkpo..
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Creating a PackitForms

e Select the form on Outpost’s Forms drop down menu
— Default web browser will start
— Form will be displayed with fields to be completed
— Note the items highlighted in RED... these are all required fields.

E Outpost Packet Message Manager

File Edit Setup Tools Forms Actions Help

New per At ICS 309 Communications Log

m XSC Check-In/Out Message
ol

pfile: | Outpost

XSC ICS-213 Message

XSC EOC-213RR Resource Requsw S [LlocallD | Subject

Out Tray XSC Qfttimtits 7
. Submit to Outpost || Submit via Email

In Tray

Reset Form | Show PDF

XSCO
XSC All
MESSAGE FORM Origin Msg #: 2 6PE-2342P Destination Msg #: °
XSCRA | sccolCs Form 213 (01/19/2022)  PIF 2.2
Generic Date ': Time (24nr) : Handling ®:] O Immediate (asap) O Priority (<1 hr) () Routine (<2 hr)l
08/10/2023 \l This message requests you to ©:
Deleted Take Action: () Yes O No
Reply: (O Yes, by O No
ICS Position: 7 ICS Position: 8
SCC Notices r Location: © ; Location: ¢ I
e —— O Name: | :: Name:
| Telephone #: | Telephone #:
Subject: 1 |
T .
Copyright 2023 Santa Clara County ARES/RACES. All righ | Reference: 7 e-g. Number of earlier msg.
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Address it to whom?

e SCCo ARES/RACES Recommended Form Routing Cheat Sheet
e PackltForms now auto-fills most forms with the

— Handling Order

— To Location

— To ICS Position
Form Type \ Handling To Location ** [ To IS Position **
General EOC
1C5-213 Message Form Author defined Author defined Author defined

If “Priority” (Field 11) is: | Then “Handling” is:
Now | Immediate (ASAP)

EOC-213RR Resource Request High (0-4 hrs) | Immediate (ASAP) County EOC Planning Section
Medium (5-12 hrs) | Priority (<1 hr)

Low (12+ hrs) | Routine (<2 hrs)

Situation Analysis Unit

OA Jurisdiction Status Immediate (ASAP) County EOC Else: Planning Section

For city-managed: Mass Care and Shelter Unit

OA Shelter Status Priority (<1 hr) fo coc:: -En?afna ed: Else: Care and Shelter Branch
FORNEN 88 | Else: Operations Section
County EOC

https://www.scc-ares-races.org/ > Forms & Signs > Go Kit Forms

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Submit the PackitForm to Outpost

e QOperator info is filled in automatically
— Operator call sign and name
— “Sent” by “Packet”
— Date and Time (when Submit button is pressed)

e C(lick the Submit button to send to Outpost

Submit to Outpost | JSubmit via Email|  Reset Form | Show PDF |

MESSAGE FORM Origin Msg #: 2 FS1-1780P Destination Msg #: 3
SCCo ICS Form 213 (01/19/2022)  PIF 2.2
Date ': Time (24hr) : Handling ° - O Immediate (AsaP) O Priority (<1 hr) ® Routine (<2 hr)

This message requests you to 6 :
Take Action: () Yes

©9/19/2022 20:13

[T A

A, i e P O bt e
e ™ Management Operations Planning Logistics

Operator Use Only: 14

Sent:

How Received () orSent @ Operator Call Sign:  W6XRL4

O Telephone O Dispatch Center Operator Name: Herman Munster

O EOC Radio O FAX O Courier
(O Amateur Radio (® Other: Packet Date: {{date}} Time:

Finance

{{time}}

p—
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Submission Successful

e Form is transferred to Outpost; OK to close this form

C O O 127.0.0.1:56732/form-7

o The message has been submitted to Outpost. You can close this page.

MESSAGE FORM Origin Msg #: 2 FS1-1780P Destination Msg #: 3
SCCo ICS Form 213 (01/19/2022) PIF 2.2
Date : Time (24hr) : Handling ®: O Immediate (AsaP) O Priority (<1hr) @ Routine (<2 hr)
09/19/2022 20:13 This message requests you to 6 :
Take Action: () Yes O No
Reply: O Yes, by O No
ICS Position: 7 Planning ICS Position: 8 Radio Operator

T Location: ¢ Xanadu EOC E Location: ¢ Xanadu Station 1

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Message Progression

Did you see what happened?

° Incom plete M essage; Fle Edit View Hisiory Bookmare ook Help
controls are grayed out,
required fields in Red,
gray banner

e Complete Message;
controls are enabled,
ready to send,
green banner.

e Submitted Message;
controls are removed;
displayed success status,
purple banner.

FS1-1780P_R_ICS213_sss X | XSCICS-213 Message X =

C @ O D 127.00.1:56732/form-8

Submit to Outpest | Submit via Email| | Reset Form || Show PDF | D = required

MESSAGE FORM

SCCo ICS Form 213 (01/19/2022) PIF 22

Origin Msg #: 2 FS1-1780P Destination Msg #: 3

Lnate 1. Time (24h) : Handling ® | O Immediate (as2P) O Priority (<1 i) O Routine (<2 hn)
o -

S —_— Bt s AR = ey

|[Eile Edit View History Bookmarks Jools Help
FS1-1780P_R_ICS213_sss x XSC ICS-213 Message X +

C @ O D 127.00.1:56732/form-8

| Submit to Outpost| Submit via Email|  Reset Form | Show PDF

| MESSAGE FORM

| SCCo ICS Form 213 (01/19/2022) PIF 22

Origin Msg #: 2 FS1-178P Destination Msg #: 3

Lilahe Hs Time (24hr) : Handling % : O Immediate (A5AP) O Priority (<1h) @ Routine (<2 h)
1 a s et Pl

§

R .

File Edit View History Bookmarks Jools Help
FS1-1780P_R_ICS213_sss x| +

C @ O D 127.00.1:56732/form-7

° The message has been submitted to Outpost. You can close this page.

MESSAGE FORM

SCCo ICS Form 213 (01/19/2022) PIF22

Origin Msg #: 2 FS1-1780P Destination Msg #: 2

Handling 5: O Immediate (asar) O Priority (<1 h) @ Routine (<2 r)

Date ': Time (24hr) :

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Error During Submission

File Edit View History Bookmarks Tools Help

Problem

3 C' | ® 127.0.0.1:60300/submit-3 @ % » =

A Something went wrong.

This information might help resolve the problem:

Opdirect isn't running, it appears.

Error: connect ECONNREFUSED 127.0.0.1:9334
{"method":"POST","host":"127.0.0.1","port":9334,"path":"/TBD"}
{"addon_name":"SCCoPIFO", "addon version":"2.17", "message status":"new",

"MSG NUMBER":"XND-1194P", "operator call sign":"W6XRL4", "operator name":"Herman
Munster", "ADDON MSG TYPE":"form-ics213.html",
"SETUP_BBS CONNECT NAME":"W1XSC-1", "emailURL":"/email-3",
"submitURL":"/submit-3", "saveURL":"/save-3", "subject":"XND-1193P R ICS213 jhg"}

log file C:\PackItForms\Outpost\SCCo\logs'2019-09-05-server-60300.log

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 77
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Correcting Submission Errors

e |s Opdirect running?

— Opdirect interfaces PackltForms to Outpost

Windows Taskbar

s | - - 15 B opdirect EMS
‘ y @ O' D 07081078 Message Monitor
e memome) el Initializing Opdirect EMS v3.6 c001
MFSNSﬁGFJF«’O!‘z rvay Ornmgn ! T Osatinsion Meg #:* Loading Profile "Outpost”
rn TR e ey Ty —— Starting up logging... passed!
s | P S e v - SRVOO0O01: Ready, Listening on Port 9334
Acke e e Reset I
_‘ SRVO001: Server ready Vi BT WBLREar DT -YSC_WIISE_Tarig - YSC Ko KPCIPhe W0 15U E
e Solution—
— In Outpost: Tools > Message Settings, Adv Tab;
M Automatically Start Opdirect...
— Restart Outpost. Verify Opdirect is running
— Press “Back” on web browser
— Click “Submit” button again
Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 78
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e An Outpost message
window appears,
containing a condensed
and formatted message

e Subject line is correctly
formatted

e Enter the “To:” address

— More on this in a bit!

e Click “Send”

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Enter the “To” Address

FS1-1780P_R_ICS213_Replacement Generator (PM:354)

File Edit Actions Window Help PopupMenu

Sendl Print | Save | Delete Clnsel Urgl Pvt | Bul NTSQ “J AIAI

Private Message

Bbs: [W1XSC-1

From [XNDFS1

To.. [XNDEOC

Subject: [FS1—1 780P_R_ICS213_Replacement Generator

|rsccopIFO!

#I: form-ics213.html
#V: 3.8-2.2

MsgNo: [FS1-17820P]

la.: [09/19/2022]

ib.: [20:13)

5.: [ROUTINE]

7.: [Logistics])

8.: [Radio Operator]
Sa.: [Xanadu EOC])

Sb.: [Xanadu Station 1}
10.: [Replacement Generator)

12,: [Generator has failed. HNeed a replacement of at least 5

KW as soon as possible.]
Rec-Sent: [sender]
OpCall: [WeXRL4]

OpName: [Herman Munster]
Method: [Other]

Other: [Packet]

CpDate: [08/18/2022]
OpTime: [20:47]

! /BDDON!

Subject line and message text fields are locked.

463
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Press Send/Receive

e Message is in the Out Tray

* Press “Send/Receive”

e Messages will be sent if...
e message is from the currently configured user (Setup > Station ID), and
e message is being sent to the currently configured BBS (Setup > BBS), and
e message is not a DRAFT message

E Outpost Packet Message Manager

File Edit Setup Tools Forms Actions Help

New | Open | Archive Delete| Print | Search Proﬁle:|

Local ID | Subject

XNDFS1 xndeoc@ W1XSC-1 FS1-2343P R ICS213 Replaceme None 360

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Delivery Receipts Es‘%}

e Message Recipient
— When you receive a message, Outpost generates a delivery receipt

— Receipts are sent during the same Send/Receive session that retrieved the
message

e Message Originator
— Receives receipt with Subject line: “DELIVERED: <original subject>"
— Message contents: the date and time downloaded by Outpost by recipient
— Eliminates the need to ask “Did you get my packet message?”

DELIVERED: F51-1780P_R_ICS213 Replacement Generator (PM:349)

File Edit View Actions Windows Help

Print | Reply | Rep : Forwardl Archive Delete CIoseJ 1 | | AlAl

Private Message
Bbs: MW1XSC-1 Recd: 9/19/2022 19:28  Sent 9/19/2022 19:24

From XNDEOC@w1xsc.ampr.org
To: XNDFS1@wixsc.amprorg

Subject: DELIVERED: FS1-1780P_R_ICS213_Replacement Generator

Your message was delivered to:
xndeoc@wlxsc.ampr.org at %/20/2022 20:27
xndeoc@wlxsc.ampr.org assigned Msg ID: XND-12&P

121
Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 81
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ADDRESSING RECAP

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 82

82

A CAarvvrinht ONOA CQAanta Clara Cnrilinthy AREQCSY/PPACEC All rinhte racarm/ad QN



Packet Operator Type Il Part B 10/2/2023

Top 5 Addressing Take-aways

5. Addresses within the SCCo packet network use the standard Internet-style
username@domain address format : usercall@bbscall.ampr.org
examples: W6XRL4@w2xsc.ampr.org
XNDEOC@w4xsc.ampr.org

4. Three different addressing formats for sending messages:
To: W6XRL4@w2xsc.ampr.org ... Full address always works!
To: W6XRLA@w2xsc ... At least always add the bbscall sign
To: W6XRL4 ... Do not use this shortcut

3. Always send to the user’s Primary BBS, unless
a) that BBS is down (then, use their Secondary BBS), or
b) that user cannot reach his/her primary BBS (bad location), or
c) you are told to use a different BBS

2. When sending from email to a packet address, send as a plain text e-mail

1. Read and understand the Packet Network Addressing Guide!
http://www.scc-ares-races.org/data/packet/packet-addressing.html
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e Quick Reference
e Network Types

— Within our network
— To other networks

From other networks
e Sending NTS Traffic
e Sending Notices

e Sending Bulletins

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

e Sending Private Messages

Complete Addressing Guide Available Online

Home

Santa Clara County ARES/RACES

Operations Data > Packet Training and Events Reference FAQ September 19, 2022

TOC |

Quick Reference |

Packet Network Addressing

Network Typpes | Private Messages | NTSTraffic | Bulletins

Table of Contents

* Quick Reference
o Sending TO a Call Sign on any Santa Clara County BBS
* Network Types
o AMPRnet
o BBS Network
o Winlink 2000
o Internet E-mail
« Sending Private Messages (SP)
o Sending Private Messages WITHIN the Santa Clara County Network
o Sending Private Messages TO Santa Clara County Users

o Sending Private Messages FROM the Santa Clara County Network
= Sending Private Messages FROM the Santa Clara County Network TO Any AMPRnet User

« Sending NTS Traffic (ST)
o NTS Address Format
o NTS Traffic Handling
o Additional NTS References
« Sending SCCo Notices
o Notice Address Format
o Notice Areas
o Reading Notices
« Sending Bulletins (SB)
o General Bulletin Address Format

o Bulletin Areas
o Reading Bulletins
o City-specific Bulletins

L0 P 8 1 PP o ettt e DB N, SR gapem el

Sending Private Messages TO Santa Clara County Users FROM the AMPRnet
Sending Private Messages TO Santa Clara County Users FROM the BBS Network
Sending Private Messages TO Santa Clara County Users FROM Winlink 2000
Sending Private Messages TO Santa Clara County Users FROM Internet E-mail
Sending Private Messages TO Santa Clara County Users FROM SMSiText

Sending Private Messages FROM the Santa Clara County Network TO Any BBS Network User
Sending Private Messages FROM the Santa Clara County Network TO Any Winlink 2000 User
Sending Private Messages FROM the Santa Clara County Network TO Any Internet E-mail User
Sending Private Messages FROM the Santa Clara County Network TO Any SMS/Text User

Categories
Distributions

https.//www.scc-ares-races.orqg/data/packet/nacket-addressing. html
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Distributing network-wide messages

NOTICES AND BULLETINS
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Notices and Bulletins: Overview |

B

— Better than a mailing list; no need to know all the desired addresses

e Bulletins are messages intended for a broad audience
— They are a great way to get information out to everyone

— When configured, Outpost will take care of retrieving them for you

e The SCCo BBSs support two types of bulletins
— SCC Notices are a special type of bulletin specific to Santa Clara County BBSs
e Only distributed to SCCo BBSs (W*XSC)
e Simple to address
e SCCo uses 3 special Notice categories

— General bulletins are used for wider (local to worldwide) distribution
e Organized by general categories (e.g.: “equake”, “ARES”), and
e Distribution ID defining how widely it is distributed (e.g.: “XSC”, “BAY”, “NCA”, etc.).
e Qutside the scope of this class (will cover in the Packet Type 2 Class!)
e Regardless of the bulletin type, when configured in Outpost, they will
automatically be downloaded

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 86
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SCCo Notice Areas N O TI CE

e SCCo ARES/RACES has four special notice categories:

— Xscperm
e Used for notices that do not expire
e examples: standard county procedures

— Xscevent
e Notices posted here automatically expire after 8 daxs
e examples: Drills, public service events, incidents, other activations

— Xsctest
— allxsc

e Where you can write city and jurisdiction notes
e Notices posted here automatically expire after 8 days
—

e Advantages
— Limits on-air time required to check bulletins

— Focuses readership so important information is not missed
— Outpost only downloads a notice once

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 87
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Outpost is Pre-Configured for SCCo Notices

BBS setup for XSC W1XSC-1

g The SCCO PaCket |nSta||er Name] Prompts | Commands | Init Commands Reh'ieving] Path |
pre-configures Outpost to Retreve these Messages
download SCCo notices Bosestoncomhlr i
— XSCPERM @ RetieweBulltins €= Lo e e
~ XSCEVENT

filter items (i.e.: QST

e |n OUtpOSt: KEPS, ARES)
— Setup > BBS, Retrieving Tab / o e

<%
— Check “Retrieve Bulletins” g o _
— Check “Custom Retrieval” R Knfie
— Custom Retrieval: |
A XSCPERM (Area) X | roor | cuon
LA (List All)
A XSCEVENT (Area)
LA (List All

LLXSC (Area)
LA (List All

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Using City Bulletins

' Custorn Retrieval
SEtup Enter az a ligt of JNOS ;XSCPERM
BBS Area and List
e Setup > BBS > Retrieving commands £ i
. , . [-I-L ALLXSC
e Change to your city’s three char prefix L> XND
(ex: “XND”, “SIC”, “MTV”, etc.) — — 5

NOTE: only one City entry is allowed.

E XND-759P_R_Donuts delivered - P~ _. .«icssage
File Edit Actigg

Create, send a city bulletin

e Start a new message

Save | Delete Closel Urgl Pvt | Bul | NTS

Bulletin Message

Bbs: |W5XSC-1

e Click the “Bul” button From: [XNDEOC
. xnd@xsc
e Address it to “xnd@xsc” Subject: [XND-759P_R_Donuts delivered

To: Xanadu Field teams,

i Enter your message and CIICk Send All requested donuts have been delivered to the ECC.

XND Logistics is working to get them distributed.

e Addressing it to @xsc distributes
to all XSC (Santa Clara County) BBSs.

See the details here...
https:/éwww.scc—ares—races.org/data/packet/packet—addressing.html#bull—citv

Copyright Z0Z3 Santa Clara County ARES/RACES. ATl Tights reservea. 89
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EVENT DOCUMENTATION
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Accuracy and Completeness

Excerpts from the FEMA | Office of Inspector General report titled “Summary
of Key Findings of Fiscal Year 2016 FEMA Disaster Grant and Audits”
— “Over the 7-year period, FYs 2009 to 2015, we found $1.64 billion, or 15

percent, in questioned costs out of the $10.9 billion that we audited, which we
recommended FEMA disallow as ineligible and unsupported costs.”

— “In fiscal year 2016, we found 5155.6 million, or 23 percent, in questioned
costs out of the 5686 million that we audited, which we recommended FEMA
disallow as ineligible and unsupported costs.”

In cases where FEMA payments were made and claims later disallowed,
recipients were required to repay these payments, with audits sometimes
taking place years later.

Because our documentation could be a used as part of the City’s justification
for either an expense reimbursement or cost recovery request, ensuring the
accuracy and completeness of what we submit is critical.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 91
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Archiving event documentation
Introduction

e The job is not done until the paperwork is complete... and
submitted.

— Every scrap of paper used during an activation is part of the event or
incident and goes to the Documentation Unit (or your Supervisor)

e |t must be legible (print)

e Use one side only
— These are legal documents that may be needed to defend decisions
— Most of this documentation is ‘discoverable’
— If itis not in the documentation, then it did not happen

— Some documentation is specifically created after the event or
incident, such as the After Action Report

e And, all this applies to our packet operations

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 92
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o Uk wN

Archiving event documentation
Introduction

e During a Packet Deployment, you will produce the following:
1.

ICS 214-SCCo Unit Activity Log

ICS 309-SCCo Communications Log (if participating on a voice net)
All third party sent & received PackltForms and plain text messages
All sent and received operator to operator packet messages

ICS 309 Communications Log (packet)

Any Form 1 / hand-scribbled / sticky notes, documentation.

e Whether it be an exercise or a real activation, when your shift is over,
your supervisor will provide instructions on wrap-up tasks that need to be
done. These can include:

— Submitting all documentation (to whom and how)

— Preparing the packet station for the next use, including archiving your
shift or the event

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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ICS 309 Communications Log (packet)

1. Create the ICS 309 Comm Log

a) From Outpost, Tools > Report Settings, 3rd
tab, “ICS309.” Enter all fields.

b) Select Forms > ICS 309 Comm Log.

c) Select Period Tab. Select Range, set the
From: and To: to the date/time range for when
your shift (or event) occurred.

d) Select Content Tab. Do not exclude anything!

e) Select Output Tab. Check output options.

NOTE: If you do not have a printer, then try the
default Microsoft Print to PDF printer.

f) Select the Signature Tab.
g) Press Build Data Set, then press Print.
h) Sign any paper-printed ICS 309 form.

i) Deliver this report to your supervisor.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Archiving event documentation

¥ 1cs 309 Comm Log Builder

File Edit Help
Build DataSet| Print |  Exit | Activation Number _ Date/Ti
[cup-23-16T 811072
Operational Period Incident Name
|08!01f2023 00:00 to 08/08/2023 19:00 [Prosped "Heights™ Earthquake
Radio Operator Name Station ID / Call Sign
IHerman Munster IWﬁXRLd

Period | Contenll Surtl Layoutl Outpull e-Signature]

Reporting Period

 Today (8/10/2023 21:31) From Date: [3/1 /2
¢ Since last report run (8/7/2023 19:14) -

From Time: [12-
" All (21412019 15:45 to 8/10/2023 21:31) {me- [12:00
* Range To Date: | g Hor2

To Time: |23:00

Preview
Date/Time From To Msg ID  Local ID Subject
Ihlh‘.‘.i:! 14:22 EKNéPT KNEPE EPL-2024P EPE-2024P_R_#1722, #170
3/4/2023 14:23 KNEPE@WLXS- KNEPE EPE-2024P EPE-2025P EPE-2024P_R_#$1722, #4170
3/4/2023 14:23 KNEPE FNEPLEWLNS~ DELIVERED: €PE-2024P_R_#
3/5/2023 12:42 KNEPZ KNEPE €PE-2020P €PE-2020P: ADIR: DL_CARF
3/5/2023 13:43 ENEPE KNEPE EPE-2020P EPEZ-2021P EPE-2020P: ADDR: DL_CARE.
3/5/2023 13:43 RNEPE KNEPE DELIVERED: €PE-2030P: AD'
3/€/2023 12:50 KDEARC ENEPE Test Outpost 3.7 - Messac
3/6/2023 13:5€ KDEARC KNEPE Test Outpost 2.7 - Measa
3/€/2023 14:17 KDEARC KNEPE Test Outpost 3.7 - Messa
3/8/2023 16:47 KDEARC ENEPE Test Outpost 3.7 - Messa
<

493 messages found for reporting
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Archiving event documentation
Printable Message Listing

. Test-data.txt - Notepad

2. Create a printable message listing

Eile Edit Format View Help
Subject: Packet Tutorial URL

a) From Outpost, File > Save All.

FYI, excellent 18 part (!) packet tutorial at

b) This will create an Ascii-formatted file http://www.choisser.com/packet/a
of all messages in the current folder From:  AAGHK

To: ALL

with a Page Break between each Sent:  6/29/2007 08:40
message Use meaninngI flle names Subject: Welcome to K6FB packet mailbox

Welcome to the K6FB packet mailbox. All are welcome

C) Repeat this Step for any other folder K6FB is located on Castle Rock Ridge, near the state
We have a digipeater (K6FB-1), mailbox (K6FB-2), and
where event messages were stored. Please use and enjoy.

- de AA6WK, K6FB packet sysop

d) Later, this file could be printed to -
generate one message per page. Or, S
. o:
because the messages are in a .txt Sent:  8/29/2021 13:02

file any message could be Copied subject: 6PE-1738P: line splift test

and pasted into another note pad,
and printed for reference.

This is line 1 that contains a lot of text that is n

e) Deliver this file to your supervisor.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 95
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Archiving event documentation
Message Archive

E Outpost Packet Message Manager

3. Create a Message Archive

File Edit Setup Tools Forms Actuons_ Help _
a) From Outpost, File > Export, then e Messge gl 10| EST [,
ave As... tri+
select “All Folders® (for your entire Save As, No Headers..
S Stem) Save All... | To | BBS
y ' Export > All Folders...
b) Use meaningful file names. e s
. S ["' , | knBpe@wi.. wixsc-1
c) The Export process will create an St - KNPE WiKSC
. . Delete All Messages ;
ALL K6FB-2
Outpost Archive File (.oaf). . S i
d) This file later can be imported back e

into Outpost to restore the archived S SR
messages to their original folders.

e) Deliver this file to your supervisor (email or USB).

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 96
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Archiving event documentation
Reset Outpost for the next event

4. Reset Outpost for the next event

STOP! Do not proceed until you have created a
' Message Archive>All Folders first.

STOP! Do not proceed until you have
“ permission from your supervisor.

a) If not already done, set up the SCC Notices message folder
a) Tools > General Settings, Start tab.
b) Set the name of one of the folders to SCC Notices.
c) Move or drag all SCC Notices into this folder.

b) Export (backup) the SCC Notices folder:
a) click on this folder. Then File > Export, select This Folder
b) Give it a name, like “SCC_Notices-yymmdd”. Press OK.
c) Verify that all messages (6 today) were exported.
d) FYI... your file is in the C:\SCC Packet\archive directory

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Archiving event documentation
Reset Outpost for the next event

4. Reset Outpost for the next event (continued)

c) Delete all Outpost messages:
a) Go to File > Delete All Messages, answer Yes at the prompt.
All your files are deleted.

d) Restore the SCC Notices:
a) File > Import, select the file, press OK

e) You now have a clean system for the next event or incident.

f) Inform your supervisor that this task is complete.
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OUTPOST TIPS

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 99
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Resend option

You did what?!!?

* You just sent a message, but ...

— it was addressed incorrectly, or
— it was sent to the wrong BBS, or
— you forgot to include all recipients, or

— it was incomplete, or

— it was the wrong message, or

— any number of other problems!

And, you don’t want to type it all back in! What now?

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 100
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Resend option — Text Messages

Outpost’s Resend option lets you resend a message previously
sent. For Text Messages...
e From the Sent folder,

E 6PE-1754P - outpostpm test (PM:1849)

File Edit View Actions Windows Help

open the message Print | Reply | Reply b| close |
. . Private Message Reply to Al
* Click on Actions > Resend... o e
. . ) et to Unrea
choose either option | Er—— ’
° The message is Opened |n Subject: 6PE-17 Add Address New Message ID
i his is a te e o im
edlt mOde' F i Copy to lcs213mm format
e Make whatever changes rovered by o
Font...
you need to make, then AN,

e Press Send, then
Send/Receive as usual.

NOTE! If you select Resend, Same Msg ID, then manually change the

Message ID -###P to -###R for Resend. This ensures no duplicate message
confusion.
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Resend option — PackltForm Messages

Resending PackitForm Messages depends on your option.
For Same Message ID...

e From the Sent folder,
single-click on the message to
highlight it (not open it) e [

Forms Actions Help

Send/Receive
Send Only

Receive Only

New Message

6PE-1743P R MuniStat

* Select Actions > Open enhanced |  OpeneVesse Ctrl-0 6PE-1742P_R_MuniStat
; K Open enhanced msg in client 6PE-1740P: URL testing

msg as text E K Open enhanced msg as text 6PE-1738P: truncation te
k ‘ . _ 6PE-1736P trincation tes

° Once the text ve I’SiOﬂ Of the form S kK Force one-time bulletin retrieve Ctrl+F 6F’E-173‘|F’__Mun|8iat

opens, click on Actions > Resend...

choose Same Message ID
e The PackltForm will open as a new copy of the message in the Browser,
just as if it was a new message for editing.
Make other changes and continue as usual.

NOTE! If you select Resend, Same Msg ID, then manually change the

Message ID -###P to -###R for Resend. This ensures no duplicate message
. e T e —
confusion.
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Resend option — PackltForm Messages

Resending PackltForm Messages depends on your option.

For New Message ID...
_ Variables | Reports | 1CS 309 |
e First get the Next Message Number a:o:;\laﬂ::e:
— In Outpost, Tools > Report Settings NextMessage [[EIl ~ Jndependent of profile settings
L Re e@this profile
— Note the Next Message value. This is Organization: |Cupertino Citizens Corps

the number to use. Do not change it! City: [City of Cupertino
1 B 1

e Then, from the Sent folder, single-click
on the message to highlight it (not open it)

e Select Actions > Open enhanced msg as text

e Once the text version of the form opens, click on Actions > Resend...
New Message ID

e The PackltForm will open in the Browser.

e Manually replace the PackltForm Origin Message Number with the
number you noted above.

e Make other changes and continue as usual.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 103
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FIELD PACKET DEPLOYMENT

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 104
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Putting it all together

1. First Shift... when assigned to establish a station

2. Initial station setup... equipment check-out, and check-in
3. Packet Operations... managing the message flow

4. Incoming Shift Change... if you are relieving someone else
5. Outgoing Shift Change... if you are being relieved

6. Securing Operations... when directed to shut down
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Field Reference

Table of Contents 1
1 QUICK REFERENCE....cusinaussssumossnmmmnssinsmunanimias s 1
2 INTRODUCTION ...cciissonimmmsmssamisississsmssrmmssnm l
2.1 PURPOSE ...t eeeeeeeeeeeeeeee e e e e eeeeseeemareeae e smanesseasnnneeeeannn .
2.2 HOW TO USE THIS HANDBOOK .....vveeeeiienrieeeeeranneeeesnssneeeenns 1
3 PACKET OPERATOR CHECKLIST.......ccooceiiimireccrnneecsnnnas f
4 PACKET STARTUP PROCEDURE.........ccceccrerininnneessnssnnnns {
5 CLIENT SO TIVARIE oososuussvasssssssamssusivsssaaimsssisissssivsmnsins ]
6 PACKET MESSAGING........cctttiiimrmnisnnssssssssssssssssssensnans i
6.1 PACKET MESSAGING BASICS..vvvvvvveeeerrressoeesseeeeseseseeseennennne i
6.2 FREE FORM (PLAIN TEXT) MESSAGE .....cccceerueernsenninsaneessnseses
6.3 SENDING A SPREADSHEET .CSV FILE +.vvnveeeeeee oo seeeaeeenon
7 MESSAGE ADDRESSING.........ccceervremrerrrnnnesssnesesssnsssssssnss }
8 STANDARD SUBJECT LINE FORMAT ....ccccccvceeeerssennsssnnnnes 1
9 CHECK-IN, CHECK-OUT MESSAGE ......c.cccerrmmrirnrnnnssssrnnns .
10 RECOMMENDED FORM ROUTINw CHEAT SHEET........... 1
11 ARCHIVING EVENT DOCUMENTATION .....ccocceevreverenrnnnnns !
11.1  CREATE THE ICS 309 COMMUNICATION LOG ..o
11.2  CREATE A PRINTABLE LIST OF YOUR MESSAGES...........................?
11.3  CREATE AN ARCHIVE OF YOUR MESSAGES.................................%
11.4  RESET (CLEANUP) OUTPOST FOR THE NEXT EVENT:
4
“M-‘__‘ru._n-t‘*'-—n_"““’ » M_’AHM_M-;
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Final Assighment

e Online Class Evaluation
— Log into https://www.scc-ares-races.org/activities/events.php

Click “Submit Class

Evaluation” in Events

Log Out
Activities Home

SCC ARES/RACES Home
Comments/Bugs
Events

Calendar of Events {

Show: Current events ® Past events ()  Event Descriptions

List Events By Date

List Events I Joined

Create a New Event
Modify an Event
Delete an Event

List/Print an Event Roster

Packet Operations Type III, Part B
| Date: Start: Type: Crea‘
10/07/23 9:00 AM County Training Yes
Course Details: Click here to visit the course description and downlo
ele...

Introduction to Emergency Communications - NIGHT CLA
Date: Start: Type: Cre

Log Event Participation
Submit Class Evaluation
My Profile

10/18/23 6:00 PM County Training Yes

Congratulations! You just got your Ham Radio license and are anxiow

concepts that yo...
. p Y o )

el el - et Sl -l mal® -

— Submit your evaluation as soon as possible... after 1 week, the form
will no longer be available for this class!
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Packet Operator Type Ill Part B

Homework

And now, for something completely different...

e Please sign up for the Monthly Packet Message Passing Exercise planned
for Wednesday 18-Oct-2023.

e These exercises simulate participating in a real event as an experienced
county packet operator who has been assigned for mutual aid support for
Xanadu County and City.

e You will be asked to pass at least two 3rd party messages in each direction
(PacketltForm) and at least two operator-to-operator messages in each
direction.

e The exercise lasts for one week, starts at 09:00 on Wednesday 18-Oct-
2023 and ends a week later on 25-Oct-2023 at 17:00. A zoom debrief
follows.

e Please register for this event here... https://www.scc-ares-
races.org/activities/eventdetail.php?id=1371.
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Packet Operator Type Il Part B 10/2/2023

Thank You!

Please complete the Course Evaluation
on or before next Saturday 8-October!

Please complete the Assignment
on or before Wednesday 25-October!

If you have questions or feedback about this or other training activities,
you can join our Training discussion group.
https://scc-ares-races.groups.io/g/packet

Make sure you're signed up for the next part:
Packet Type Il

Questions, comments, suggestions?
knbpe@arrl.net
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